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CHAPTER 1 - GETTING STARTED WITH POWER PIVOT

1.1 What is Power Pivot?

Power Pivot is an add-in for Microsoft Excel which allows you to analyse complex data quickly and 
efficiently.  It provides several advantages over basic Excel pivot tables, including:

Feature Description
Multiple tables A pivot table based on a Power Pivot data model can include columns from multiple 

different tables.  This allows you to combine data from different sources into a single 
pivot table.

Table size Tables which you load into a Power Pivot data model can have approximately 2 billion 
rows and columns, far exceeding the size of a table in an Excel worksheet.

Measures You can use the DAX language to write calculations called measures in a Power Pivot 
data model.  DAX measures allow you create much more complicated and useful 
calculations than you can create using Excel formulae alone.

3D maps With a Power Pivot data model you can use Power Map to create a fancy-looking 3D 
map of your data!

The Power Pivot Workflow

To create a report using Power Pivot you tend to follow the same sequence of steps or workflow.  
You can see the basic Power Pivot workflow in the diagram below:

You can gather data from many different data sources including 
Excel, text files, databases, websites and more.  You can import 
each data source into a separate table in Power Pivot.

You can use the Power Query editor to filter and modify the data 
as you import it.  This allows you to clean messy data and mould 
it into a form that makes it usable in Power Pivot.

You can use your Power Pivot data model to create pivot tables, 
pivot charts and even 3D maps in your Excel workbook.

Creating a data model involves many tasks, including: creating 
relationships between the various tables you have imported; 
renaming tables and columns to make them easy to recognise; 
assigning data categories and default formatting to columns; and 
creating calculated columns, measures and KPIs.
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Enabling Power Pivot in Excel

You may need to enable the Power Pivot feature before you can use it.  To do this:

1) From the Excel ribbon, choose File | Options.

2) On the dialog box which appears, choose Add-ins.

3) From the Manage: drop down list, select COM Add-ins then click  Go...  

4) Check the box for Microsoft Power Pivot for Excel and click  OK  

The Power Pivot Ribbon Tab

Once you have enabled Power Pivot you’ll see an extra tab in the Excel ribbon.

Choose this option from 
the left hand panel.

Choose COM Add-ins 
then click this button.

Check this box and 
then click OK.

You can use the buttons in this group to add different 
types of calculated values to the data model.

Relationships are an important part of a data model – 
this button helps you to create them automatically.

The Manage button opens the Power 
Pivot application so that you can work 
with the data model.

Use this button to add an 
Excel table to the Power 
Pivot data model.

You can use this button to change 
some basic settings of the Power 
Pivot application.
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1.2 A Basic Power Pivot Example

This section shows you the basic Power Pivot workflow using a single Excel worksheet containing 
sales data from a fictitious toy company called Create a Creature.

Step 1 – Create an Excel Table

To add the data to the Power Pivot data model we first need to convert the range of cells into a 
formal table.  To do this, select any cell in the table and from the ribbon choose Insert | Table.

Our sample data is held in a single Excel worksheet.  Each row represents a sale made in one of our shops and has 
information about the product and location of the sale.

For this basic example, we’ll create the Power Pivot data model in the workbook 
which contains the original data.  Normally, you would import data into the data 
model from an external source.

Wise 
Owl’s 
Hint

a) Select any single cell in the 
table and choose this option 
on the Insert tab.

b) Check this box if your table 
has headers then click OK.

c) Optionally, give your table a better 
name on the Table Design tab of 
the ribbon.
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Step 2 – Add the Table to the Data Model

To add your freshly created table to the Power Pivot data model, select any cell in the table and from 
the Excel ribbon choose Power Pivot | Add to Data Model

Excel will copy the selected table into the data model and then open the Power Pivot application to 
show you the results.

b) From the Excel ribbon 
choose Power Pivot | 
Add to Data Model.

a) Select any cell in the 
table that you want to 
add to the data model.

The Power Pivot application opens in 
a separate window.  You can click this 
button to return to the Excel workbook.

The Power Pivot ribbon contains options for 
working with the data that you have added 
to the data model.

The default view in Power Pivot is the Data view.  In 
this view, each table that you add to the data model sits 
in a separate tab (here there’s only one).  You can click 
the different tabs to view the data in each table.

The other view of a data model is 
the Diagram view.  You can switch 
between the views using these two 
buttons.
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Step 3 – Edit the Data Model

Editing a data model involves several different tasks.  One of the simplest things you can do is assign 
a default format to a column.  You can see how to do this in the diagram below:

Step 4 – Create a Report

To create a report you can add pivot tables and charts based on the data model.  To do this, from 
the Power Pivot ribbon choose Home | PivotTable and then choose what to create.

a) Select the column you want to 
format by clicking any cell in the 
column.

b) In the Home tab of the ribbon, 
select the formatting you want 
to apply.

Unlike in Excel, you can’t format individual cells in a Power Pivot column.  The entire 
column is treated as one object when it comes to changing formatting and other 
properties.

Wise 
Owl’s 
Hint

a) Click the bottom 
half of the button 
then pick which 
type of report to 
create.  Here I’m 
adding a single 
pivot table.

b) Choose where to place the selected pivot table 
or chart in the workbook.  I’m choosing to place 
the pivot table on a new worksheet.

c) Click OK to return to the Excel window and create the pivot table or 
chart in the selected location in the workbook.  Now you can build 
the pivot table, as described overleaf.
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Step 5 – Build the Pivot Table

You can now build the pivot table by adding fields from your data model to the different areas of the 
pivot table.  You can see how to do this in the diagram below:

You can see one of many possible configurations for this pivot table in the diagram below.

When you click in the pivot table on the 
worksheet, the PivotTable Fields pane 
appears on the right of the screen

The top half of the PivotTable Fields pane lists the columns in the 
data model.  You can tick a box next to a column name to add it to 
the default area of the pivot table.

You can also click and drag a 
column from the list into one 
of the four areas of the pivot 
table below.

Each of the fields you add to an area in 
the PivotTable Fields pane…

…is added to the appropriate part of the pivot table on the 
worksheet.
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CHAPTER 2 - DATA MODELS

2.1 Building Data Models

In the previous chapter you saw how to create a basic data model consisting of a single table.  This 
chapter explains how to build a more complex data model involving multiple tables.

Our Example Data Model

Our data model will be based on a database of sales for our fictitious Create a Creature toy 
company.  You can see a diagram of the data model we want to create in the image below:

Each row in the Sales table represents 
an event involving the sale of a product 
in one of our centres.  This table is the 
fact table of our model.

The other tables provide ways for us to group and aggregate the data.  
These are referred to as dimension tables.  We can split these tables 
into two groups: one related to the location of a sale, and another 
related to the details of the product that was sold.

Each table is joined to 
at least one other in a 
relationship, shown as 
lines between tables.

Relationships in a model are called many-to-one 
relationships.  For example, we have many sales 
for one product; many products belong to one 
family, and so on.

The * symbol shows the many 
end of a relationship.  The 1 
symbol shows the one end of 
the relationship.
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Our Example Data

Our sample data is stored in a separate Excel file.  You can see how some of the Excel data is 
arranged in the diagram below:

In this version of the Create a Creature file, 
rather than storing everything in a single 
worksheet, we’ve used separate sheets to 
store the different elements involved in a sale.

The Sales worksheet has one row for each 
sale.  The SaleID column contains a unique 
number for each sale.  This type of column is 
sometimes referred to as a primary key and 
allows us to uniquely identify each row.

In the ProductId column we add 
the id number of the product that 
was sold, here it’s 2.  This type of 
column is sometimes referred to 
as a foreign key.

The Product table stores each 
product once, using a unique id to 
identify it.  We can look up this id 
to find the product’s details.  Id 2 
corresponds to Pokyo Penguin.

Each product belongs to a specific habitat.  We 
record the id number of the habitat for each 
product in the Product table.  Many products 
can belong to one habitat.

The Habitat table stores each habitat once and 
uses a unique id number to identify each one.  
We can look up the id number to find the details 
of each habitat.

Every table in our database is connected to at least one other via an id column.  
Storing data in this way reduces how much repeating data we must store.  It also 
makes it easier to update information as each item is stored only once.

Wise 
Owl’s 
Hint
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2.2 Importing Data

To create our data model, we’ll import data from the Create a Creature workbook into a blank Excel 
file.

Which Application to Use

You can import data into a data model using the import tools in either Excel or Power Pivot.

It doesn’t really matter which tool you use as the data ends up in the same place, but each application 
has different advantages, as described in the table below:

Application Description
Excel Provides a wider range of data sources from which to import your data.  The import tool 

allows you to use the Power Query editor for making changes to the data.  You can also 
choose to load the imported data into an Excel table rather than just the Power Pivot data 
model (although it’s unlikely you’ll want to do this).

Power Pivot The import tool allows you to rename tables and columns and apply basic filters as part of 
the import process.

In this chapter we’ll use the import tool in Power Pivot.  You can learn how to use Excel’s import 
feature in a separate chapter of this manual.

To use Excel’s tools to import data, from 
the ribbon choose Data and pick an 
option from the Get & Transform Data 
group.

To use Power Pivot’s import 
tools, from the ribbon choose 
Home and pick an option from 
the Get External Data group.

The Power Query editor is such a powerful feature that Wise Owl recommend 
importing your data using Excel’s import tools rather than Power Pivot’s.

Wise 
Owl’s 
Hint



Chapter 2 - Data Models

© Copyright 2025  Page 17

2.3 Importing Data in Power Pivot

To begin importing data, in a blank Excel workbook open Power Pivot by choosing Power Pivot | 
Manage from the Excel ribbon.  You can now follow the steps shown below.

Step 1 - Choose to Import from Excel

To choose to import an Excel workbook, from the Power Pivot ribbon, choose Home | From Other 
Sources.

Step 2 – Choose the Excel File

Choose to browse for the Excel file containing the data you want to import.

On the dialog box which appears, 
scroll to the bottom of the list and 
pick Excel File.

Click Next > to go the next stage 
of the import process.

Click Browse… 
to open the file 
browser dialog 
box.

Find and double-click the file containing 
the data you want to import.

Check this box to 
indicate that the 
first row of each 
sheet contains the 
column headers, 
then click Next >.
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Step 3 – Choose and Rename Tables

Select the tables you want to import from the Excel file and optionally rename them.

Step 4 – Apply Filters

You can optionally filter each table to include only the data you need in your data model.

Tick the box next to each table 
that you want to import.  You 
can tick the box at the top to 
quickly select every table in 
the list.

You can rename each table to 
make them easier to recognise 
when creating your reports.  
To do this, type the new name 
in the Friendly Name column.

Select a table in the list and then click 
Preview & Filter to see the data it 
contains.

Click the drop down arrow next to a 
column header to see the filters you 
can apply to the values in the column.

Choose the filters you want to apply to the column and then click OK.

You can choose not to import an entire column by unchecking the box 
next to its name.  It’s good practice to import only the data you need.
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Step 5 – Finish Importing the Data

The final step is to finish importing the data, as shown in the diagram below:

Click the Finish button to commit your choices 
and import the selected data.

A dialog box appears to show you the progress 
of the import.

When the import has finished, click Close to see 
the data you have imported.

Each table you chose to import 
appears on a separate tab in 
the data view of Power Pivot. 
You can click a tab to see the 
data it contains.
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2.4 Power Pivot Views

You can view a data model in either the data view or diagram view.  You can switch between the 
views in two ways, as shown in the diagram below:

The Data View

In the data view you can see the information contained in each table.

The Diagram View

The diagram view shows a picture of the relationships between the tables in your data model.  If 
you’ve only just imported your data it’s unlikely that you’ll see any relationships yet!

You can use these buttons in the Home tab of the ribbon to switch between the two views.

Or use these buttons in the bottom right corner of the Power Pivot window.

The top half of the data view shows the data 
in the selected table.  Although this looks a 
little like an Excel worksheet, you can’t edit 
the data in this view.

The bottom half of the table contains an area 
for creating calculations called measures.

You can click a table’s tab to see the data it 
contains.

Each table in the data model is displayed 
as a box listing the table’s columns.

You can click and drag on the table name 
to move it around in the diagram.

You can zoom in and out using the zoom 
controls, or by rolling your mouse wheel.
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2.5 Editing Tables and Columns

After importing data it’s worth spending time editing the tables and columns to make them as easy 
to use as possible in your reports.

Viewing Table Properties

You can view the properties of a table in the data model which allows you to choose which columns 
to import and modify the table’s filters.  To do this:

You can make these changes in either the data view or the diagram view.  You may 
find it easier to perform different tasks in one view or the other.

Wise 
Owl’s 
Hint

a) Select the table in either the data or 
diagram view and from the ribbon 
choose Design | Table Properties.

b) Check or uncheck the box next 
to a column name to add it to or 
remove it from the table.

c) Click the drop down 
list next to a column 
to apply a filter to it.

d) Click Save to apply 
your changes and 
update the model.

You might expect to be able to view table properties by right-clicking on a table and 
choosing an option from the context menu, but you can’t!

Wise 
Owl’s 
Hint
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Deleting Columns

Rather than using the Table Properties dialog box, you can remove a column from a table by 
choosing to delete it.

Deleting Tables

You can remove an entire table from the data model by choosing to delete it.

Renaming Tables and Columns

The easiest way to rename a table or a column is to double-click its name in either the data view or 
the diagram view.

Right click on a table name and choose 
Delete.  Alternatively, select the table 
and press  Del  on your keyboard.  In the 
diagram view the selected table will be 
faded out.

Confirm that you want to delete the 
table from the model.  If you want to get 
it back, you’ll need to import it again.

Right-click on the column you want to remove and 
choose Delete.  Alternatively, select the column and 
press  Del  on your keyboard.

Confirm that you want to delete the column.

a) Double-click on the name 
you want to change.

b) Edit the 
name.

c) Press  Enter   to commit the 
new name.



Chapter 2 - Data Models

© Copyright 2025  Page 23

Changing Column Data Types

In Power Pivot the values in one column must all have the same type.  Power Pivot will assign data 
types to columns automatically, but you can change these if you want to.  To do this:

Formatting Columns

Formatting a column in the data model means that you don’t have to repeatedly format it each time 
you add it to a pivot table or chart.

Select the column and 
use the formatting tools 
on the Home tab of the 
Power Pivot ribbon.

You’ll see different options 
depending on the data 
type of the column.  Here 
we’re formatting dates.

It’s worth setting the data type of any identifier columns to Whole Number.  This will 
help when it comes to creating relationships between tables.

Wise 
Owl’s 
Hint

a) Select the column whose data type you want to change and 
look for the Data Type option on the Home tab of the ribbon.  
Here the Quantity column is set to Decimal Number but we 
don’t sell pieces of products!

b) Choose the new data type for the column.  Here we’re setting 
Quantity to be stored as a Whole Number.

c) Confirm that you want to change 
the column’s data type.
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Setting Default Aggregations

When you add a field to a pivot table, it will be aggregated in a default way: numeric values will be 
summed, text values will be counted.  You can change the default aggregation as shown below:

Hiding Tables and Columns

You can hide columns and tables so that they don’t clutter up the list of fields in Excel.

You can easily unhide any hidden tables or 
columns, as shown below:

It’s easiest to hide multiple fields in the diagram view.  You can hold  Ctrl  and click 
on fields in multiple different tables in this view.

Wise 
Owl’s 
Hint

Select the columns or tables you 
want to hide.  You can hold  Ctrl  to 
select multiple items.

Right-click on a selected item and 
choose Hide from Client Tools.

When you create a pivot table, the 
Excel field list will not show the 
items you chose to hide.

Select the items you 
want to unhide then 
right-click on one of 
them and choose 
Unhide from Client 
Tools.

Select a column and from the ribbon 
choose Advanced | Summarize By.

Choose which function to apply to 
the column when you add it to the 
pivot table.
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2.6 Table Relationships

Relationships are a vital part of a data model which includes multiple tables, as this section shows!

The Need for Relationships

Without relationships between tables in the data model, pivot tables can produce strange results.

To produce the correct results, our pivot table must be able to filter the values of the Quantity column 
by the Region in which the sale was made.  Without relationships, this can’t work.

We’ve tried to create a pivot table to 
show the total quantity of products sold 
in each region, but it shows the wrong 
results.

The problem is that we’ve used fields 
from two different tables but the tables 
have no relationship.

To show the correct result, the filter applied by the Region table must be able to travel, or propagate, to 
the Sales table.  Without relationships, the filter has no route to travel along, so every region shows the 
grand total of the Quantity column.



Chapter 2 - Data Models

© Copyright 2025  Page 26

Detecting Relationships

One way to create relationships is to ask Power Pivot to detect them automatically.  For this to work, 
the columns involved in the relationship must meet certain criteria, as described in the table below:

Criteria Description
Data types The data types of the two columns must be the same and be either text or whole number.

Column names The column names must be similar although they don’t need to be identical.  For example, 
RegionId, Region Id and Region_Id are similar enough for Power Pivot to infer a 
relationship.

Key values Every value in the foreign key column must exist in the primary key column.  For example, 
in the Town table the RegionId column must only contain values which exist in the 
RegionId column of the Region table.

To automatically detect relationships, create a pivot table using fields from different tables, then:

You can view the relationships in the diagram view of Power Pivot.

a) At the top of the fields pane in Excel, 
click Auto-Detect…

b) Wait for the detection process to end 
and then click Close.

c) Check that the pivot table 
shows updated results.

Each relationship appears as a line between 
two tables.  You can hover the mouse over a 
line to highlight the columns in the relationship.

Power Pivot tries to create all the relationships needed 
for a filter to propagate from the Region table through 
to the Sales table.
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Creating Relationships Manually

If Power Pivot can’t automatically detect relationships, you can create them manually.  The easiest 
way to do this is to click and drag fields in the diagram view.

If you’d rather not click and drag, you can create a relationship using a dialog box.  You can see one 
way to do this in the diagram below:

Click and drag a column from one table and drop it on 
the column you want to relate it to.  It doesn’t matter 
which way round you do this.

After creating the relationship, hover the mouse over 
the line to highlight the columns you’ve related.

b) In the bottom half of the dialog box, 
select the table you want to create a 
relationship to.

a) Right-click on a column and choose 
Create Relationship…  The top half 
of the dialog box which appears will 
automatically select the table and 
column you have right-clicked on.

c) Click the column you want to create 
the relationship to then click OK.

You can also create a relationship by choosing Design | Create Relationship from 
the Power Pivot ribbon.

Wise 
Owl’s 
Hint
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Deleting Relationships

You can delete a relationship as shown in the diagram below:

Managing Relationships

You can see a list of all the relationships in your data model by choosing Design | Manage 
Relationships from the Power Pivot ribbon.

a) Right-click on the relationship you want to delete 
and choose Delete.

b) Confirm that you want to delete the relationship.

You can create new relationships using the Manage Relationships dialog box.  You can also 
edit or delete and existing relationship by selecting it and clicking the appropriate button.

The dialog box shows information about each relationship, including its type and the direction in 
which filters travel from one table to the other.
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2.7 Refreshing a Data Model

If your source data changes, you’ll want your data model to update to reflect those changes.

Refreshing Data in Power Pivot

In Power Pivot, you can choose to refresh a single table or every table in the data model.

Refreshing Data in Excel

You can choose to refresh data in Excel using the Queries & Connections pane.  To open this 
pane, from the Excel ribbon choose Data | Queries & Connections.

Refreshing Data Automatically

You can set a connection to refresh automatically as shown in the diagram below:

From the ribbon pick Home | Refresh then 
choose Refresh to refresh the table you have 
selected or Refresh All to refresh every table.

A dialog box appears after the data refreshes.

Select the Connections tab and then find the connection 
you want to refresh in the list below.

You can click this button next to the connection to refresh it.  
Alternatively, right-click the connection and choose Refresh.

In the Queries & Connections pane, right click the connection and 
choose Properties…

Tick the relevant boxes to 
control when the connection 
refreshes then click OK.
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 Visual C#   
   

  VB programming    
 

  MySQL  
   

  Python  
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